MT5 User Guide

MT5 User
Guide

Risk Disclosure: Trading foreign exchange on margin carries a high level of risk, and may not be suitable for all investors. The high degree of leverage can work against you as well as for
you. Before deciding to trade foreign exchange you should carefully consider your investment objectives, level of experience and risk appetite. The possibility exists that you could sustain
a loss of some or all of your initial investment and therefore you should not invest money that you cannot afford to lose. You should be aware of all the risks associated with foreign exchange
trading, and seek advice from an independent financial advisor.
This report is provided as general market commentary and do not constitute investment advice. Fullerton Markets is not liable for any losses or damages, including without limitation to any
loss of profits, which may result from the use of this report.

MT5 User Guide

Contents
How to open a demo account
Live Account Opening
Connect to an account
Deposit and Withdrawal
Platform Settings
Password Change
Trading Parameters
Executing Trades
opening positions
placing an order
General order parameters
Managing stop levels
Closing positions
Placing Limit orders
Placing Stop orders
Placing Stop limit orders
Help topics

3-7
8
9
10
11
12
13-14
15

16
17-18
19
20
21
22
23

Risk Disclosure: Trading foreign exchange on margin carries a high level of risk, and may not be suitable for all investors. The high degree of leverage can work against you as well as for
you. Before deciding to trade foreign exchange you should carefully consider your investment objectives, level of experience and risk appetite. The possibility exists that you could sustain
a loss of some or all of your initial investment and therefore you should not invest money that you cannot afford to lose. You should be aware of all the risks associated with foreign exchange
trading, and seek advice from an independent financial advisor.
This report is provided as general market commentary and do not constitute investment advice. Fullerton Markets is not liable for any losses or damages, including without limitation to any
loss of profits, which may result from the use of this report.

MT5 User Guide

How to Open a Demo Account
Demo accounts provide the opportunity to work in a training mode without real money,
allowing to test a trading strategy. To open a demo account you need to select a trading server
and specify registration data. After you have opened an account, the platform connects to a
server. You can now work in the platform.
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Open an Account
Two types of accounts are available in the trading platform: demonstration (demo) and real.
Demo accounts provide the opportunity to work in a training mode without real money,
allowing to test a trading strategy. They feature all the same functionality as the live ones.
The difference is that demo accounts can be opened without any investment and, therefore,
one cannot expect to profit from them.
Demo Account Opening
Click "Open an Account" in the File menu or in the context menu of the Navigator window.

The account opening procedure consists of several steps:
Select a Server
A broker is selected during the first step. If the desired company is not shown in the list,
please type its name and click "Find your broker". Alternatively, you can type the address of
the server instead of the company name. Once you find the desired company, select it and
click "Next".
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Account Type
Enter the details of your existing account or create a new one.
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Personal Details
Enter your personal details:

If you agree with account opening terms and the broker's data protection policy, tick the appropriate
box and click "Next". After that, the account will be created.
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Account Registration
Once an account is created on a selected server, details will be shown in the dialog window:

The upper part of the window contains brief information about the account; the lower part
shows its details:
•
•
•

Login — the number of the opened account.
Password — a password to access the account. This is a master password, which
allows trading from this account.
Investor — investor password. The password allows connecting to the account to
view its state and analyze price dynamics, but it does not allow trading.
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Live Account Opening
Directly from the trading platform, you can send a request to open a live account, on which
you can trading using real money. You will need to fill out a few simple forms, and to
additionally provide documents to confirm your identity and address.
Choose the option "Open a real account for live trading" and specify the required data:

Once you fill in all fields, a preliminary account with the zero balance will be opened for you
on the broker's server. Although you cannot trade on a preliminary account, you can monitor
price dynamics, perform technical analysis and test strategies.
An informational email is additionally sent to you via the internal mailing system when a
preliminary account is opened.
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Connect to an Account
To start working with a trading account, you need to connect to it using a login (account
number) and password. Two types of account access are available in the trading platform:
master and investor. Logging in using the master password gives full rights for working with
the account. Investor authorization allows you to see the account status, analyze prices, and
work with your own Expert Advisors, but not trade. The Investor access is a convenient tool
for demonstrating the trading process on the account.

Specify the following data in this window:
•
•

Login — the number of the account used for connection.
Password — the master or investor password for the account.

Enable the "Save password" option, and the next time you start the platform, the last used account will
be automatically connected to the server. Option "Keep personal settings and data at startup" in the
platform settings performs the same action.
After specifying all the details, click "OK" to connect.
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Deposit and withdrawal
The trading platform allows quickly switching to deposit/withdrawal operations on the broker
website. You do not need to search for these functions in the trader's room, while fast
navigation commands are available directly in terminals: in the accounts menu in Navigator
and in Toolbox:
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Platform Settings
The trading platform provides multiple settings to help you conveniently customize it. Click
"Options" in the Tools menu or press "Ctrl+O".

All settings are grouped in several tabs based on what they do:
•
•
•
•

•
•
•
•

•

Server — setup of server connection, configuration of a proxy server, and other important
settings;
Charts — common settings of price charts and parameters of objects management: object
selection straight after creation, immediate object configuration, and docking parameters;
Trade — default parameters applied to the opening of new orders. They include: financial
instrument, number of lots, deviation, and placing of stop orders;
Expert Advisors — common settings for all Expert Advisors. They include: disabling
operation of Expert Advisors, enabling importing functions from external DLL libraries and
Expert Advisors, as well as a number of other features;
Events — configuration of alerts of system events. You receive important alerts about
connection loss, arrival of newsletters and other events;
Notifications — sending push notifications to mobile devices from the trading platform;
Email — email parameters for sending messages straight from the platform;
FTP — settings for publishing reports on the Internet. The trading platform allows saving and
automatically publishing reports about the account state in real time. This is done over ftp
based connection, which can be configured in this tab;
Community — details of your MQL5.community account
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Password Change
To change the account password, click "Edit". After that the following window opens:

The following details are to be indicated in the password changing dialog:
•
•
•
•
•
•

Login — account number, this field cannot be changed;
Current password — the field to enter the master password;
Change master password — select this option if you want to change the master
password of your account;
Change investor password — select this option if you want to change the investor
password of your account;
New password — field for entering a new password;
Confirm — field for confirming a new password.

After specifying all the data click "OK".
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Trading
This tab features settings used for opening orders. Parameters specified here facilitate
opening of orders and cannot cause critical changes in the platform operation.

Use these options to set default parameters applied when opening orders:
•

Symbol — this option allows to define a symbol that will be automatically added to
the position opening window. The "Automatic" parameter means that the active chart
symbol will be set in this field, the "Last used" — the symbol of the latest trade
operation. If "Default" parameter is selected, you can specify a certain financial
instrument that will be automatically set for all positions.

•

Volume — this option adds a certain volume in the position opening window, quick
trading panel on the chart and a trading panel in Market Watch. The "Last Used"
parameter means that the volume of a previous operation will be selected. The
"Default" parameter allows to specify a certain volume to be indicated automatically
for all positions.
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•

•

•

•

Deviation — symbol price may change during order creation. As a result, the price of
a prepared order will differ from the market one, and the position will not be opened.
The "Use Deviation" option helps to avoid this. When "Default" parameter is set, to
the right of this field you can set the maximum acceptable price deviation from the
value indicated in the order. If prices are not identical, the program modifies the order
and a new position is opened. If "Last Used" is selected, the deviation value of the
previous opened position will be automatically set in the order opening window.
Stop levels — settings for the Stop Loss and Take Profit levels that will be added
when placing orders or modifying positions. If the "in points" variant is chosen, stop
levels will be specified in the number of points from the price of order placing. If the
"in prices" variant is chosen, it will be necessary to specify the certain price level for
stop levels.
One click trading — to use this option, you need to accept special terms and
conditions. The one-click trading option allows performing trade operations in one
click without additional confirmation by trader (trade dialog is not displayed). The
one-click trading feature is implemented in the following parts of the platform:

•
•
•
•

the Trading tab in Market Watch,
the quick trading panel on the chart,
the Trade tab in the Toolbox window,
Depth of Market.

•

Show realtime history of deals on chart — when this option is enabled, all the deals
performed by a trader are automatically displayed on the chart of the corresponding
symbols with the icons (a Buy deal) and (a Sell deal). When you point the mouse
cursor to an icon, a tooltip appears containing information about the deal: ticket, deal
type, volume, symbol, open price and current price coordinate of the cursor.
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Executing Trades
The trading activity in the platform implies forming and sending market and pending orders
to be executed by a broker, as well as managing current positions by modifying or closing
them. In the platform, you can review your account trading history, configure alerts of market
events and much more.
Opening Positions
Opening of a position or entering the market is the primary purchase or sale of a certain
amount of a financial instrument. In the trading platform, this can be done by placing a
market order, as a result of which a deal is executed. A position can also be opened as a result
of a triggered pending order.
Placing an Order and General Parameters
There are several ways to call a dialog window for order creation:
•
•
•

Select a symbol in the Market Watch and click "New order" in its context menu.
Press the F9 hot key. In the order window, a symbol will be inserted in accordance with the
platform settings.
Click “New order" in the Tools menu or "New order" on the Standard toolbar.
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General order parameters:
•
•
•

•

•

•

•
•

Symbol— the financial instrument to perform a deal for.
Type — if one of the execution modes is selected in this field, a market operation is executed
for the selected instrument. Otherwise a pending order of the selected type is placed.
Volume — the volume of an order in lots. The greater the volume of a deal, the greater is its
potential profit or loss, depending on where the symbol price will go. The deal volume also
affects the margin reserved on the trading account for the position.
Stop Loss — the Stop Loss level as a price or in the number of points from the price specified
in order, depending on the platform settings. The level is set to limit the position loss. If you
leave the null value in this field, this type of order will not be set.
Take Profit — the Take Profit level as a price or in the number of points from the price
specified in order, depending on the platform settings. The level is set to lock in profits of the
position. If you leave the null value in this field, this type of order will not be set.
Comment — an optional text comment to an order. The maximum comment length is 31
characters. The comment appears in the list of open positions and also in the history of orders
and deals. A comment to an order can be changed by a broker or server. For example, if a
position is closed by Stop Loss or Take Profit, the corresponding information is added in the
comment.

To send a buy order click Buy, to send a sell order click Sell.
Once an order is sent, its execution results appear in the window — a successful trade
operation or a reason why it has not been executed. If One Click Trading is enabled in
the platform settings, upon successful order execution the trading window closes
without notifying of execution results.
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Managing Stop Levels from a Chart
Modification of Stop Loss and Take Profit on a chart is only available if the "Show trade
levels" option is enabled in the platform settings.
To modify the level on a chart, left-click on it and drag the level up or down to the required
value holding the mouse button (Drag'n'Drop):

Once a level is set, the position modification window appears allowing users to adjust the
level more precisely.
Placing Stop Levels from a Context Menu
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If an open position is available for the instrument of the chart, its stop levels can be set from
the "Trade" submenu of the chart's context menu:

The price for the stop order is set according to the current location of a cursor on the chart
price scale. Depending on the position open price and its direction, appropriate commands for
placing Stop Loss or Take Profit appear in the menu.
The command opens the order modification window, where the price can be adjusted
manually.
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Closing Positions
In order to profit from exchange rate differences, it is necessary to close the position. To
close a position, a trade operation opposite to the first one is executed. For example, if the
first trade operation was buying one lot of GOLD, one lot of the same security must be sold
to close the position.
To close an entire position, double-click on it or use the command "Close Position" in its
context menu on the "Trade" tab.

Upon clicking "Close..." the position is closed.
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Placing Limit Orders
Limit orders are placed in the expectation of price "rollback". The trader expects the price
reaches a certain level, for example support or resistance, and then moves in the opposite
direction.
These orders are executed at a price equal to the specified one or better than that.
Accordingly, no slippage occurs during order execution. The downside of these orders is that
their execution is not guaranteed, since the broker may reject an order if the price goes too far
in the opposite direction.
Here is how we can place a Buy Limit order.

In this example, the price is at the level of 1.25350, and the trader places a limit order to buy
at the price of 1.24620 expecting that the price will reach the support level of 1.24453 and
will continue to move upwards.
It is the opposite for Sell Limit orders. They are placed in anticipation that the price will rise
to a certain level and will go down.

Risk Disclosure: Trading foreign exchange on margin carries a high level of risk, and may not be suitable for all investors. The high degree of leverage can work against you as well as for
you. Before deciding to trade foreign exchange you should carefully consider your investment objectives, level of experience and risk appetite. The possibility exists that you could sustain
a loss of some or all of your initial investment and therefore you should not invest money that you cannot afford to lose. You should be aware of all the risks associated with foreign exchange
trading, and seek advice from an independent financial advisor.
This report is provided as general market commentary and do not constitute investment advice. Fullerton Markets is not liable for any losses or damages, including without limitation to any
loss of profits, which may result from the use of this report.

MT5 User Guide

Placing Stop Orders
Stop orders imply expected breakthrough of certain levels. The trader expects the price to
reach a certain level, break it through and move on in the same direction. The trader assumes
that the market has reversed, having reached the support or resistance level.
When such an order triggers, a request to execute a corresponding market order is sent to a
broker. The order is executed at the price equal to the specified one or worse than that. In
other words, if the market price goes opposite, the order will be filled with a slippage.
However, unlike limit orders, the execution of stop orders is guaranteed.

In this example, the price is at the level of 1.28190, and the trader places a stop order to sell
at the price of 1.27600 assuming that the market has reversed at the level of 1.28260 and will
move downwards.
It is the opposite for Buy Stop orders. They are placed assuming that the market has reversed,
and the price will rise.
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Placing Stop Limit Orders
This is a combination of a stop and a limit order. If the price reaches the stop price, a limit
order is placed. This type of orders is used when a trader wants to set a stop order and limit
the slippage.
In the example below, a stop-limit order is placed with the expectation that the price will
reach the resistance level 1, will roll back from it, and then will rise to the resistance level 2.
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Help Topics
Further to this guide clients can get help with the inbuilt MT5 platform user guide. You can
find this at “Help > Help Topics” or press F1. Alternatively, you can also visit the online
guide from MetaTrader5 here at https://www.metatrader5.com/en/terminal/help
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